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Legal Information
Trademarks
XTOOL is a registered trademark of Shenzhen XTOOL Technology Co., Ltd., in the
United States and other countries. This publication includes trademarks owned by
Shenzhen XTOOL Technology Co., Ltd., such as XTOOL. Any other trademarks
mentioned are the property of their respective owners.

Copyright Information
No part of this manual may be reproduced, stored in a retrieval system or
transmitted, in any form or by any means, electronic, mechanical, photocopying,
recording, or otherwise without the prior written permission of XTOOL.

© 2017 Shenzhen XTOOL Technology Co., Ltd. All rights reserved.

Disclaimer of Warranties and Limitation of Liabilities
The pictures and illustrations are for reference only. The information, specifications,
and illustrations in this manual were accurate when it was printed and may change
without notice. The authors have taken care in preparing this manual, but it does
not:

● Change the standard terms and conditions of the purchase, lease, or rental
agreement through which the equipment covered by this manual was acquired.

● Increase liability to the customer or third parties in any way.

XTOOL will not be responsible for any direct, special, incidental, or indirect damages,
including economic losses such as lost profits.
XTOOL® also reserves the right to make changes at any time without prior notice.

IMPORTANT:
Before you start using or maintaining this unit, make sure to read this manual
thoroughly. Pay close attention to the safety warnings and precautions provided.



Product Support Information
Technical Assistance
Website: https://www.xtoolonline.com
Mail: support@xtoolonline.com
ADD: 17&18/F, A2 Building, Creative City, Liuxian Avenue, Nanshan District,
Shenzhen, China
Corporate & Business: business@xtoolonline.com, sales@xtoolonline.com

Manuals / Technical Documentation
This manual is periodically revised to ensure the latest information is included.

Product Training Videos
Diagnostic Tool specific training videos are available on our website. Follow along
and learn the basics of Diagnostic Tool operation with our free training videos.
Videos are product specific and are available at: https://www.xtoolonline.com
/support/product-videos Click on the "Support"- "Product Videos"-"Diagnostic Tools"
tab, select the applicable Diagnostic Tool, then select the training video you want to
watch.

Safety Information
For your safety, the safety of others, and to prevent damage to devices and vehicles,
it is crucial to read and understand all safety instructions presented in this manual
before operating or coming into contact with the device.

General Safety Instructions:
● Read and Understand: Ensure that all operators and individuals in the vicinity of
the device have read and understood the safety instructions.

● Proper Use: Only use the device as described in this manual. Always adhere to the
safety messages and test procedures provided by the vehicle or equipment
manufacturer.

https://www.xtoolonline.com/
mailto:support@xtoolonline.com
mailto:business@xtoolonline.com,
https://www.xtoolonline.com


● Knowledge and Skill: The automotive technician must be knowledgeable about the
system being tested. Familiarize yourself with proper service methods and test
procedures.

● Acceptable Testing Practices: Perform tests in a manner that ensures your safety,
the safety of others, and prevents damage to the device and the vehicle.

Specific Responsibilities:
● Refer to Manufacturer Guidelines: Always consult and follow the safety messages

and applicable test procedures from the vehicle or equipment manufacturer
before using the device.

● Use Appropriate Tools and Techniques: Due to the variety of test applications and
product variations, it's important to use the correct tools and techniques for each
specific task.

● Anticipate Safety Requirements: While this manual provides comprehensive
guidance, it cannot cover every potential situation. Technicians must be prepared
to handle unforeseen circumstances safely.

By adhering to these guidelines and responsibilities, you can ensure a safe and
effective working environment while using the device.

Safety Messages
Safety messages are included to prevent both personal injury and damage to
equipment. Each safety message begins with a signal word that indicates the level of
hazard involved.

Danger
This signal word "indicates an imminently hazardous situation which, if not avoided,
will result in death or serious injury to the operator or to bystanders."

Warning
This signal word "indicates a potentially hazardous situation which, if not avoided,
could result in death or serious injury to the operator or to bystanders."



Safety Instructions
The safety messages provided here address situations that XTOOL is aware of. XTOOL
cannot anticipate, evaluate, or provide advice on all potential hazards. You must be
certain that any condition or service procedure encountered does not jeopardize
your personal safety.

Danger
When the engine is running, ensure the service area is well ventilated or connect a
building exhaust removal system to the engine exhaust. Engines emit carbon
monoxide, a colorless and poisonous gas that can impair reaction times and lead to
serious injury or even death.

Safety Warnings
Safe Environment: Always perform automotive testing in a safe environment.
Eye Protection:Wear safety eye protection that meets ANSI standards.
Avoid Hazards: Keep clothing, hair, hands, tools, and test equipment away from all
moving or hot engine parts.
Ventilation: Operate the vehicle in a well-ventilated work area to avoid inhaling
poisonous exhaust gases.
Transmission and Brakes: Put the transmission in PARK (for automatic) or NEUTRAL
(for manual) and ensure the parking brake is engaged.
Wheel Blocks: Place blocks in front of the drive wheels and never leave the vehicle
unattended while testing.
Ignition System Caution: Be extra cautious around the ignition coil, distributor cap,
ignition wires, and spark plugs, as these components generate hazardous voltages
when the engine is running.
Fire Extinguisher: Keep a fire extinguisher suitable for gasoline, chemical, and
electrical fires nearby.
Test Equipment Connections: Do not connect or disconnect any test equipment
while the ignition is on or the engine is running.
Clean Equipment: Keep the test equipment dry, clean, and free from oil, water, or
grease. Use a mild detergent on a clean cloth to clean the outside of the equipment
as necessary.



No Driving While Testing: Do not drive the vehicle and operate the test equipment
simultaneously to avoid distractions that may cause an accident.
Service Manual Reference: Refer to the service manual for the vehicle being
serviced and adhere to all diagnostic procedures and precautions. Failure to do so
may result in personal injury or damage to the test equipment.
Battery Check: Ensure the vehicle battery is fully charged and the connection to the
vehicle DLC is clean and secure to avoid damaging the test equipment or generating
false data.
Avoid Electromagnetic Interference: Do not place the test device on the vehicle's
distributor, as strong electromagnetic interference can damage the device.
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1. Introduction
The XTOOL D7 Diagnostic Tool interfaces with the electronic control unit(ECU) of a
vehicle to retrieve diagnostic trouble codes (DTCs), access data stream information,
and command actuation tests (bi-directional control tests). Various vehicle control
systems, such as engine, transmission, and anti-lock brake system (ABS), SRS(Airbag)
system, Chassis, Body and etc are readily diagnosed using this Diagnostic Tool. The
Diagnostic Tool is capable of graphing up to eight (8) live data parameters on a single
screen, and also includes ECU information.

This chapter introduces the basic features of the Diagnostic Tool, including the
control buttons, data ports, battery pack, and power sources. Technical
Specifications are provided at the end of this chapter.

1.1 Data and Power Connections

1.2 Battery Pack
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1.3 Main Ports of The Tablet

1.4 Power Sources
XTOOL D7 Diagnostic Tool can receive power from either of the two sources:
● Internal Battery Pack
● AC Power Supply

❶ 7-inch Touch Screen
❷ Power Button
❸DB15-Port
❹Micro USB Port
❺ Speaker
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1.5 Internal Battery Pack
The D7 Diagnostic Tool can be powered from the internal rechargeable battery pack.
A fully charged battery provides sufficient power for about 3.5 hours of continuous
operation.
Battery charging occurs when the Diagnostic Tool is connected to the AC Power
Supply and to a live AC power source.

1.6 AC Power Supply
You can power the Diagnostic Tool by connecting it to a standard AC outlet using the
AC power supply. The connector at the end of the output cable from the AC power
supply should be plugged into the DC power supply input jack located on the top of
the Diagnostic Tool. It's important to use only the AC power supply that was
provided specifically for this purpose to ensure proper and safe operation of the
tool.

1.7 Technical Specifications
Item Description/Specification

Display 7 Inch Touch Screen, 1024×600 Resolution

Operating System Android 10.0

Processor Quad-Core Processor 1.5GHz

Memory 2G RAM,32G ROM

Connectivity Micro USB+Wi-Fi(2.4Ghz & 5Ghz)

operating method flat panel touchscreen

Upgrade Method Device connects to Wi-Fi for online upgrade

Battery ( 3.7V lithium-polymer battery, 4000mAh)

Tested Batter Life 3.5 Hours

Dimensions 21.8*15*2.9(CM)

Wi-Fi 2.4G/5Ghz

Power Consumption 8W

Free Renewal Update 3 Years

Charging method Type-C charging

Sensor Gravity/ Light Sensor
Audio Microphone

Speaker Built-In Speaker
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Weight(Including Battery) 0.72KG

Gross Weight 2.2KG

Operating Temp Range(Ambient) -4°F ~ 140°F (-20°C ~ 60°C)

Storage Temp(Ambient) -40~158°F (-40~70°C)

Operating Humidity <90%

1.8 What's In The Box
Name QTY

D7 1

VAG to OBD-II-16 Main Cable 1

Charger for Tablet 1

Charger US Adapter 1

Charger EU Adapter 1

Micro USB Cable 1

P700 1

Tool kit 1

User Manual 1

Packing List 1

Carton 1

2.Getting Stared
Ensure that the Diagnostic Tool is adequately powered by either checking its battery
status or connecting it to an external power supply (refer to Power Sources on page
2 for details).

NOTE:
The images and illustrations depicted in this manual may differ from the actual ones
due to color discrepancies and image reproduction quality.
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Turning On/Off and Force Shut Down
The following sections explain how to turn the XTOOL D7 Diagnostic Tool on and off,
as well as how to perform an emergency shutdown.

2.1 Turning On
To turn on the XTOOL D7 Diagnostic Tool, press and hold the power button located
on the top right of the device for approximately five seconds. The tool will
automatically power on if the internal battery pack has sufficient charge or if it is
connected to an AC power supply. If the internal battery pack is completely drained,
you need to charge it for more than 6 hours and then turn it on again.

2.2 Turning Off
To turn off the XTOOL D7 Diagnostic Tool, press and hold the power button for more
than three seconds. The tool will then automatically power off.

IMPORTANT:
Before turning off the XTOOL D7 Diagnostic Tool, make sure to terminate all vehicle
communications. If you try to power off the tool while it is still communicating with
the vehicle, a warning message will appear. Forcing a shutdown during
communication could potentially cause issues with the ECM (Engine Control Module)
on certain vehicles. It's crucial never to disconnect the DBD-15 main cable while the
Diagnostic Tool is actively communicating with the vehicle ECM.

2.3 Emergency Shutdown
During normal operation turn the Diagnostic Tool off using the Turning Off procedure
above. The emergency shutdown procedure should only be used If the Diagnostic
Tool does not respond to navigation or control buttons or exhibits erratic operation.
To force an emergency shutdown, press and hold the Power button for five seconds
until the Diagnostic Tool turns off.
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IMPORTANT:
Using the emergency shutdown procedure while communicating with the vehicle
ECM may lead to ECM problems on some vehicles.

3.Get to Know the Diagnostic Tool
This chapter details the layout and icons of the main diagnostic screen and main
screen of the Android tablet used with the Diagnostic Tool.

3.1 Diagnostic Screen Layout & Diagnostic Screen Icons
When you turn on the Diagnostic Tool, it automatically starts the diagnostic program,
and you will see the diagnostic screen appear. The Diagnostic Tool utilizes a hidden
toolbar located at the bottom of the diagnostic tablet. Swiping up from the bottom
of the screen will reveal this toolbar for a period of 3 seconds. The section below will
provide details about the layout of the diagnostic screen and describe the icons
found on the toolbar.

3.2 Diagnostic Screen Layout
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3.3 Diagnostic Screen Icons

3.3.1 Auto Scan
The Diagnostic Tool automatically detects and decodes the VIN (Vehicle
Identification Number), then proceeds to scan comprehensively through all available
vehicle electronic control modules for diagnostics. This process ensures thorough
assessment and identification of potential issues across the vehicle's systems.

3.3.2 Diagnostic
Clicking "Diagnostic" icon will bring up the diagnostic menu. From there, you can
navigate using Auto VIN to automatically detect the vehicle's details, manually input
vehicle information such as make, model, year, and configurations for diagnostics,
access the DEMO program, and perform OBD-II tests.

3.3.3 Special Function
This section covers the most commonly performed maintenance services used by
both car repair Do-It-Yourselves and professionals for day-to-day auto maintenance
tasks.

NOTE:
Functions with the same name may have different vehicle coverage for special
functions on the main diagnostic menu compared to those under the diagnostic job
menu.

3.3.4 Report
This section includes functions for diagnostic reports, data playback, and data
viewing.

3.3.5 Updates
This section allow you to download diagnostic software programs individually or in
batch.
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3.3.6 More
This section enables you to perform several tasks:
● Set up the user account and workshop profile, if applicable.
● Check the subscription period.
● Access firmware information.
● Use the endoscope function.
● View the user manual in PDF format.

3.3.7 Settings
In this section, you can customize the language of the Android tablet, choose units of
measurement, configure USB mode and operating system settings, adjust the
volume and brightness levels of the tablet, and review information such as the App
version, OS version, Serial Number of the Diagnostic Tool.

3.3.8 Remote Control
Clicking "Remote Control" icon will launch TeamViewer for remote control assistance.
Ensure that TeamViewer is in "ready to connect" status before the scheduled remote
assistance appointment. The TeamViewer ID will be displayed on the right side, and
the connection status can be seen at the bottom left corner.
The "Remote Control" menu is generally used when you need tech support from us
and we are not able to help you fix it via emails or messages. Then we will set an
appointment with you at a time that is suitable for you and the engineers. You are
not able to start a remote control without an appointment because we don't know
that you started it. There are too many devices sold in the market, we are not able to
remote with all customers if they start the remote at the same time without
appointment.

3.3.9 XTOOL
This section provides information about how to contact us, including our social
media accounts for support or any other inquiries.
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3.4 Hidden Toolbar Menu, Main Screen Layout & Main Screen
Icons
Swiping up from the bottom of the touchscreen will reveal the toolbar for 3 seconds.
Clicking the home button on this toolbar will bring up the main screen of the
diagnostic tablet. On the tablet page, you can freely switch between horizontal and
vertical screens. The following sections describe the layout and icons of the main
screen.

3.4.1 Hidden Toolbar Menu
Screenshot icon, take a screenshot on what's on the screen.
Volume Down icon, press to decrease the volume of the speaker of the Android
tablet.
Back icon, press to back one step from the current menu.
Home icon, press to go to the main screen of the Android tablet.
Volume Up icon, press to raise the volume of the speaker of the Android tablet.
Diagnostic program shortcut, press this icon to run the diagnostic program.
Screen Recording icon, press this icon to start recording the screen including
the surrounding sound. Press the icon again to end the screen recording
process.
Background cleanup icon, press the icon to clean up the background running of
the APP, which can make the tablet run faster.
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3.5 Main Screen Layout

3.6 Function of each icon
3.6.1 Calender
This function displays the calender in day, week and month.
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3.6.2 Contacts
This function enables you to manage your contact information. You can add a new
contact by clicking the "+" icon at the bottom right, or import contacts in bulk from a
VCF file by clicking "IMPORT".

3.6.3 Clock
This function allows you to set alarms, timers, use the stopwatch, and access the
clock.
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3.6.4 Email
This function lets you create a new email account for sending emails or sharing
reports.

3.6.5 Music
This function allows you to add new songs, playlists, albums, artists, and more.
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3.6.6 Sound Recorder
This function enables you to record a voice message.

3.6.7 Calculator
This function opens the calculator.
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3.6.8 Files
This function allows you to manage documents, reports, files, and folders stored in
the memory.

3.6.9 Adobe Acrobat
This function enables you to manage PDF files and access your Dropbox account
after logging into your Adobe and Dropbox accounts.
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3.6.10 Quick Support
This function enables our tech support team to remotely control the Diagnostic Tool.
This allows them to check for possible problems with the tool or assist you with
navigation paths and other issues.

3.6.11 Settings
This function allows you to configure Android tablet settings, including Network &
Internet connections, battery management, display settings, sound volume control,
and checking memory storage.
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3.6.12 Gallery
This function allows you to view screenshots and screen recordings.

3.6.13 Browser
This function allows you to get product support from XTOOL website and search
information.
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3.7 Connect to USB Type-C Port for Data Transfer
To enable data transfer between the Diagnostic Tool and a PC, please follow these
steps:
Step 1: Connect the Diagnostic Tool to a PC by using a Type-C cable. Insert one end
into the Type-C port on the Diagnostic Tool and the other end into a USB 2.0 port on
the PC.
Step 2: Swipe down from either the upper right or upper left corner of the
Diagnostic Tool to bring up the drop-down menu. Click on "Android System. USB file
transfer turned on".

Step 3: Change the option from "No data transfer" to "File Transfer".
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Step 4: On the PC, check the connected devices and click on "D7" to access and
manage the files stored in the internal memory of the Diagnostic Tool.

3.8 Red-Green Color Blindness Color Correction Mode
To set the Diagnostic Tool to red-green color blindness color correction mode, follow
these steps:

Step 1: Swipe up from the bottom of the screen to bring up the hidden menu.
Step 2: Click the home button to switch to the main screen of the Android tablet.
Step 3: Navigate to Settings > Accessibility.
Step 4: Scroll down to find "Color correction" and toggle "Use color correction" to
the on position.

4.How to Diagnose Vehicles
This chapter covers the fundamental operation of the Diagnostic Tool function.
● The Diagnosis icon is situated on the Home screen.
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● The Diagnostic Tool function enables communication with a vehicle's electronic
control systems. This capability allows you to retrieve diagnostic trouble codes
(DTCs), view PID data, conduct actuation tests, and perform advanced functions
such as resets, relearns, matchings, adaptations, initializations, and more.

4.1 My Vehicles
"My vehicles" function allows you to add the diagnostic programs you use often to
save time navigating the vehicles.
Click "Diagnostic" icon on the diagnostic screen, you will see "My vehicles" listed in
the top taskbar.
To add diagnostic program that you use often into this section, click the add icon>
select the region where the vehicle brand is originated> select the brands you often
use> click "completed" to finish adding brands operations.
To remove a diagnostic program for "My vehicles" list, click the pen icon select the
diagnostic program you want to remove> click "Remove" to finish removing it from
the list.

4.1.1 Vehicle Coverage List
The "Vehicle Coverage List" displays compatible vehicle makes, models, and years for
the queried function. To access it, select Diagnostic > Region, where you will find a
PDF icon at the top right corner of each diagnostic program. Clicking the PDF icon
will bring up the Vehicle Coverage List (or Compatibility List) for that particular
diagnostic program.

IMPORTANT:
The vehicle makes, models, and years listed in the Vehicle Coverage List are not
updated daily and may not be accurate at the time of your inquiry. The Vehicle
Coverage List is provided for reference purposes only. For the most current vehicle
coverage information, please consult your sales representative or our support team.
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4.1.2 Compatibility Check
This Diagnostic Tool is compatible with all OBD-II vehicles for performing generic
OBD-II tests, as well as a wide range of vehicle makes and models across regions like
the United States, Europe, Asia, Australia, etc., for comprehensive electronic control
systems diagnostics. However, the specific functions available for each vehicle may
vary, even among vehicles of the same make, model, and year.

IMPORTANT:
Special Functions on the main diagnostic screen are not universally available for all
vehicles. The availability of functions for a specific vehicle depends on compatibility,
which requires verification using the vehicle's VIN (Vehicle Identification Number),
make, model, and year.

To check compatibility, please consult tech support via support@xtoolonline.com at
any time or refer to our website: https://www.xtoolonline.com
/support/vehicle-coverage (for reference only, subject to confirmation from tech
support: support@xtoolonline.com).

4.2 Software Program Version
This Diagnostic Tool displays the current software program version at the bottom of
each vehicle manufacturer's screen. For instance, the current installed KIA software
program is V14.10, as depicted in the picture below.

mailto:support@xtoolonline.com
https://www.xtoolonline.com
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The red up arrow indicates that there is a newer version of the software program
available for download. When you click on the arrow to update the software
program and successfully install it, the Diagnostic Tool will display that a newer
version of the software program has been installed.
If there is no red arrow indicator, it means that your software packages are all
updated to the latest version.

4.3 Demo Program
The "DEMO" program simulates the vehicle navigation process, displays available
function options, and demonstrates the appearance of the menu. You can use this
DEMO program to practice using the Diagnostic Tool functions before activating the
tool. It serves as a training tool to familiarize yourself with the operations and
capabilities of the Diagnostic Tool.

IMPORTANT:
The DEMO program may not display the most current vehicle diagnostic procedures
or the actual screen interface. It is not intended for checking vehicle coverage or
compatibility.
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4.4 Trial Mode
The DEMO program may not accurately represent the latest vehicle diagnostic
processes or the actual screen interface. It is crucial to understand that this program
is not designed for vehicle coverage or compatibility checks. Its main purpose is to
offer practice and help users become familiar with the functions and user interface
of the Diagnostic Tool.

4.5 Wi-Fi Connection
This Diagnostic Tool can connect to 2.4 GHz or 5.0 GHz frequency hotspot or Wi-Fi.
Swipe up the hidden bottom toolbar and see the tab menu. Click Home> Network &
Internet> Switch on Wi-Fi connection> Click Wi-Fi icon to view Wi-Fi available> Select
the Wi-Fi you want to connect and input password to connect.
If your Wi-Fi connection is not functioning well, or if you are in an area without
access to home Wi-Fi, you can connect to your mobile phone hotspot instead.
How to turn on the mobile hotspot
● For iOS users
Go to Settings> Turn on cellular network> Personal Hotspot> Switch on "Allow
Others to Join" and "Maximize Compatibility" to set your phone and connect to the
hotspot from your Diagnostic Tool following the steps above.
● For Android users
Go to Settings> Wireless & networks> Tethering & portable hotspot> Portable WLAN
hotspot> Switch on hotspot> Configure WLAN hotspot> Encryption Type> WPA2 PSK
Show advanced options and make sure "Max connections allowed" has user left for
the Diagnostic Tool.

NOTE:
Wi-Fi connection is not necessary for diagnostics with most vehicle brands. However,
for certain brands like Peugeot, which require access to an online server during
diagnostics, it is essential to connect to Wi-Fi.
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4.6 Product Activation
Step 1: After first-time users press and hold the power button to turn on the system,
the system will automatically enter the guided process and request the user to select
the language for the operating system. Click "Register": Open the registration page.

Step 2: After setting the system language, click Next to enter the Wi-Fi connection
page, as shown below:
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Step 3: Select a network to connect to on the Wi-Fi connection page. You need to
enter the Wi-Fi password to establish Wi-Fi connectivity and the activation page, as
shown in the figure below. You can also click the "TRAIL" button in the upper right
corner to try it out before activation. However, activation is highly recommended to
take advance of any new online software updates.

Step 4: Click Start Activation to enter the activation page, as shown below:
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Step 5: A pop-up window showing "Activation success" indicates that you have
completed the first boot setup.

Step 6: Click "OK" to enter the diagnostic system and start using the device.

Step 7: Once you see "Registration completed" on the screen, the Diagnostic Tool
has been successfully registered and activated. You can now use the email address
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and password you set for logging in. The Diagnostic Tool will remember your account
information, so you won't need to log in every time.

NOTE:
If you are unable to register the Diagnostic Tool or you can't see the activation
screen, contact our support team via support@xtoolonline.com.

If you forget your password, click "New password" and input your email address and
click "Get verification code". You will receive a verification code from
service@xtool.com and input the verification code to proceed to reset the password.
If you don't see the verification code in the inbox, please check the spam box as well.
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If you forgot the email address you used for the product activation, please send the
S/N (Serial Number) of the Diagnostic Tool to support@xtoolonline.com to recover
the registration information.

4.7 Vehicle Connection
⚫ DB15 to OBD2-16 Main Cable

❶DB15 Port-connect to tablet

❷OBD2-16 Male Connector-
connect to vehicle’s OBD port
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⚫ Vehicle Connection
The scan tool must be connected to the vehicle's OBD-II port so that the tablet can
establish correct vehicle communication.

Please perform the following steps:
Step 1: Turn on the tablet
Step 2: Connect vehicle and tablet via the main test cable
Step 3: Switch on the ignition and tap on the Diagnostic application to start your
diagnosis. The connection method is shown in the figure below:

❶ Vehicle
❷ DB15 to OBD2-16 Main Cable
❸ Tablet

4.8 Diagnose Vehicles
To ensure proper communication and diagnostics, the vehicle must be correctly
identified. The vehicle identification sequence is menu-driven, and you should follow
the screen prompts to enter the required information. Exact procedures may vary by
the make, model, and year of the vehicle.

Steps to Identify a Vehicle: Follow these steps to establish communication between
the Diagnostic Tool and the vehicle.
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Step 1: Follow Screen Prompts: Use the menu-driven prompts to enter the necessary
vehicle information.
Step 2: Options for Vehicle Identification:
⚫ VIN (Vehicle Identification Number)
⚫ Manufacture area> Model> Year
⚫ Other specific criteria as required by the Diagnostic Tool

4.8.1 Vehicle Identification
Click "Auto Scan" icon on the diagnostic screen, and the Diagnostic Tool will scan the
vehicle VIN and decode the VIN for vehicle identification automatically.

IMPORTANT:
There is a common misconception that the Diagnostic Tool cannot communicate
with a vehicle for diagnostics if it fails to detect or decode the VIN number. If the
Auto Scan option fails, it's recommended to try other vehicle identification options
instead. Use "Manual Selection" as your final but reliable solution to input the
vehicle's make, model, and year manually. This ensures you can proceed with
diagnostics even if automatic VIN detection is unsuccessful.

NOTE:
Auto Scan functionality may not be compatible with all vehicles. If Auto Scan fails to
work, it's advisable to try alternative options instead.

4.8.2 Diagnostic
Click "Diagnostic" icon on the diagnostic screen, the Diagnostic Tool will bring up

vehicle selection menu. Click the " " icon at the top left corner, and you will see
"Auto Scan" and "Manual Input" icons available. Click "Manual Input" to input the
vehicle VIN number (17 digits) manually and the Diagnostic Tool will decode the VIN
number and identify the vehicle.
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NOTE:
In cases where vehicle VIN numbers cannot be decoded, if both Auto Scan and
Manual Input failed, it is recommended to try using Automatic Detection or Manual
Selection instead.

4.8.3 Automatic Detection
Click "Diagnostic"> Select region where the vehicle brand is originated, for example
"Americas"> Select the vehicle brand, for example "CADILLAC"> Select "Automatic
Detection" to automatically detect and identify the vehicle the Diagnostic Tool is
connected to.

NOTE:
Automatic Detection may not function with all vehicle models. If none of the three
options mentioned above are successful, it is advisable to choose Manual Selection
instead.

4.8.4 Manual Selection
When the "Auto Scan", "Manual Input" and "Automatic Detection" fails to identify
the vehicle, you can always select "Manual Selection" to identify the vehicle and
proceed to diagnostics. Manual Selection is the most reliable vehicle identification
option.
To identify a vehicle through "Manual Selection", click "Diagnostic"> Select region
where the vehicle brand is originated, for example "Americas"> Select the vehicle
brand, for example "CADILLAC"> Select "Manual Selection"> Select the model year>
Model Name and you may go through a few other selections before you see
"Automatic Scan" and "System Selection" on the screen.

4.8.5 Automatic Scan
It is to scan all available vehicle modules for diagnostics.
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After performing an automatic scan, the Diagnostic Tool will display the vehicle
systems affected by faults and the number of failures in orange at the top of the
screen.

4.9 Submit Feedback
Clicking the message icon " " in the top right corner allows you to submit feedback
to our support team if you encounter any issues with the app or the software
programs.
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4.10 CAN fast Scan
Scanning all available vehicle systems for vehicles that use the CAN protocol for
vehicle communication post-2005 is much faster.

4.11 System Selection
Once you have identified where the car problems might be, you can select an
individual vehicle module for diagnostics. This allows for more targeted and efficient
troubleshooting.

4.12 Diagnostics
When the vehicle has been identified correctly, the Diagnostic Tool will be able to
scan and access the vehicle electronic control systems to pull diagnostic trouble
codes (DTCs), retrieve PID data (Parameter IDs), freeze frame, ECU information and
perform diagnostic tests like actuation tests(bi-directional controls) and advanced
resets, relearns, matchings, adaptations and initializations.

4.12.1 Read Codes
When viewing diagnostic trouble code (DTC) records retrieved from the vehicle's
electronic control module, selecting them may open a sub-menu with viewing
options.
During the diagnosis process, if the Diagnostic Tool displays "System is OK" or "No
Trouble Code," it indicates either no related fault codes stored in the ECU or faults
that are not monitored by that specific ECU. Many faults are related to mechanical
system faults or issues with the circuit's operation. It's also possible that a sensor
signal may be inaccurate but within acceptable limits, which can be further
examined using Live Data (PID data).

4.12.2 Clear Codes
Erases DTC records, including both current and historical data, along with other
stored information from the vehicle's electronic control module (ECM).
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When the erase command is sent through the diagnostic program, the vehicle's
electronic control module (ECM) will verify whether the issue has been resolved over
several drive cycles. Some faults are immediately detected by the ECU when the key
is in the run position, even without the engine running. However, other faults may
require very specific test conditions to be met, such as engine coolant temperature
within a specific range, vehicle speed maintained within a range for a duration of
time, throttle position within a certain range, and so on.

4.12.2.1 DTC Erased While Fault Remains
If fault codes are erased while the underlying issue remains unresolved, the fault
code will reappear after a few drive cycles.

4.12.2.2 DTC Erased and Fault Fixed- History Code
If the fault has already been fixed but a trouble code is still stored, sometimes the
ECU will detect the resolution and either clear the fault code or classify it as a
historical code.
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4.12.2.3 DTC Erased and Fault Fixed- History Cleared
If the fault is fixed and you clear the fault codes, the fault history will also be cleared.
If you intend to have another technician investigate the car problem, it's not
recommended to clear the fault code, as this may erase valuable information that
could be helpful to others investigating the issue.

NOTE:
Clearing codes typically erases the freeze frame data associated with those codes.

4.12.3 PID Data
Displays PID data for various sensors from the vehicle electronic control module. This
Diagnostic Tool allows viewing real-time PID data of various sensors in a list, view
individual PID data in graphing, analog dashboard, setting maximum and minimum
values, view custom PID data up to 8 sensors in a list, individual graphing and
merged graphing.

4.12.3.1 PID Data List
Click live data function and the Diagnostic Tool will display a list of PID names and
real-time values on the screen as show in picture below:
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4.12.3.2 Individual PID Data Graphing
Click the "custom" icon on the lower right corner to view graphing for individual PID
data and click chart to choose the format you want as shown in picture below:

With the click of "chart" button you can choose from four viewing modes: List,
Column, Graph, 2D-Graph.

List mode:
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Graph mode：

2D-Graph mode：
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Column mode:

4.12.3.3 Set Maximum &Minimum Value Alarms

Click " " icon on the right to set maximum and minimum value alarms for
individual PID data as shown in picture below:
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Once the maximum and minimum values are set on the screen, the diagnostic tool
will display colors based on the values to indicate whether the PID data exceeds the
maximum value or falls below the minimum value you have just set, as shown in the
image below:

With the click of "chart" button you can choose from four viewing modes： List,
Column, Graph, 2D-Graph.
List mode:
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Column mode:

Graph mode:
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2D-Graph mode:

NOTE:
The maximum and minimum values do not have to be within the normal value range
for the specific PID data. You may set whatever value you deem fit for you
observation.

4.12.3.4 Zoom In & Zoom Out & View In Full Screen
Click the magnifier icon to zoom in the x-axis up to 3 times and click the

magnifier icon to zoom in the y-axis up to 3 times. When it shows 3 times for
x-axis or y-axis on the screen, press the magnifier icons again and it will show its
original size (X1) again.



41

4.12.3.5 Custom Up to 8 PID Data
This Diagnostic Tool allows you to tick the boxes for up to 8(eight) PID data and click
"Custom" to show custom list of real-time PID data.

Cancel Selected - To cancel the PID data you selected so that you can re-select them.
Custom - Proceed to display the custom screen for the PID data you selected.
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Record - Recorded data streams
Pause - To pause the continuous retrieving process for the real-time PID data.

4.12.3.6 Individual Graphing for Up to 8 PID Data
Click the "custom" icon on the custom PID data list screen, and the Diagnostic Tool
will show individual list for up to 8 PID data on one single screen, as shown in picture
below:

With the click of "chart" button you can choose from four viewing modes： List,
Column, Graph, 2D-Graph.
List mode:
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Column mode:

Graph mode:
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Display All - If you want to view or display other PID data, this button allows you to
show all available data streams again for selection, so you don't have to go back and
choose them again.
Chart - Select the display format you need: List, Column, Graph, 2D-Graph.
Record - To record the PID data for later review in Data Playback.
Pause - To pause the continuous retrieving process for the real-time PID data.

4.12.3.7 8-In-1 Graphing
Click "Chart - 2D-Graph" to combine individual data bars into a single chart and
display it as an image.

The places have highlighted can be ticked directly to show the data flow, without
having to go back and re-select it.
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4.12.14 Fold & Unfold PID Data Name
This Diagnostic Tool allows you to fold the PID data name list so that you can view
the merged graphs in a bigger screen. To fold the PID data name list, click the up
arrow icon as shown below:
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To unfold it, click the down arrow icon if you want to check the name of the PID
data.

4.12.3.8 Data Recording & Playback
Click the "Record" icon will start recording the PID data for later review through
"Report" function.

The Diagnostic Tool allows recording the PID data or graphing for later playback. To
check recorded PID data, go to Report- Data Playback and click the recorded file to
playback.

Click "Pause" button to pause the PID data retrieving process.

4.12.3.9 Export Data as CSV & Data View
When you click the record button, the "save" button will blink, proving that the data
stream has begun to record, when you want to end the recording, click the "save"
button again, then you can save the recorded data stream.
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When you have done collecting the PID data, click back icon on the top left and a
prompt will pop up on the screen for you to rename the CSV file. Clicking "PREVIEW"
will allow you to review the generated CSV file.
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4.12.4 Data View
When you have exported the PID data as CSV file, this Diagnostic Tool allows you to
view the CSV file on the screen. Go to Main Diagnostic Screen- Report- Data View as
shown in picture below:

Click "CSV View" icon and you will see all CSV file exported as in picture below:
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Click the file you want to review and the Diagnostic Tool will display as below:

Click "Chart" to choose from four display options: List, Column, Graph and 2D-Graph.

4.12.5 Export CSV File to a PC
You may export the exported CSV file to a PC for storage or later review as well.
Follow the steps below to find the CSV file:

Step 1: Connect the Diagnostic Tool to a PC through the USB Type-C cable.
Step 2: Swipe down from the upper right corner of the Diagnostic Tool and enable
"Data Transfer".
Step 3: Follow the path on your computer and find the CSV file you want to export:
My computer > D7 > Internal Shared Storage > Diagnosis > CSV records, select the
CSV file you want to export and copy it to your PC memory.

4.12.6 Share CSV File via Bluetooth
If you want to share the CSV file to an Android tablet or phone, you may follow the
path below:
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Step 1: Swipe up the hidden toolbar and click home icon to go to main screen of the
Android tablet.
Step 2: Click "File"> Local > Home > Diagnosis> CSV_records > Press and hold the
CSV file you want to export to activate the selection box> tick the box> Click "More"
at the bottom left of the screen> Share > Bluetooth > select the device you want to
share.

NOTE:
You can not share the file to a device that runs iOS system from Android tablet.

4.12.7 Freeze Frame
When a fault code is triggered, the vehicle ECU will save related data at that moment
to generate a freeze frame. It is usually used to analyze the root cause that triggers
the fault code, together with fault codes and PID data.

Freeze frame displayed varies across vehicles. Some vehicles may not have the
option of freeze frame which means that the vehicle does not support this function.
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4.12.8 Actuation Tests(Bi-Directional Controls)
Actuation tests, often known as bi-directional controls or bi-directional tests, checks
the operation of certain actuators, such as solenoid, valves and relays.
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4.12.9 Special Function
The Diagnostic Tool can perform advanced functions such as resets, relearns,
matchings, adaptations, initializations, and more. The available menu options may
vary depending on the vehicle being diagnosed.
The special functions listed under the diagnostic menu include some that are also
found under "Special Function" on the main diagnostic screen. However, the
diagnostic menu offers a broader range of options compared to those available on
the main diagnostic screen.

4.12.10 Exiting Diagnostics
Diagnostics remain active as long as there is an active communication link with the
vehicle. To exit tests and turn off the Diagnostic Tool, you must first interrupt this
communication link. A warning message will appear if you manage to shut down the
Diagnostic Tool while it is communicating with the vehicle.

NOTE:
Damage to the vehicle electronic control module (ECU) may occur if communication
is disrupted. Ensure that the main cable is properly connected at all times during
testing. Exit all tests before disconnecting the main cable or turning off the
Diagnostic Tool.

4.12.11 To Exit the Diagnostics:
Pressing the back button on the screen until you reach the main menu, or closing
the diagnostic program entirely, will interrupt vehicle communication and exit
diagnostics.

4.13 Full System Diagnostic Report
After completing the diagnostics and returning to the main diagnostic screen, enter
the VIN number, mileage, and model year. Click "OK" in the report generating form
to create a diagnostic report for later review or sharing.
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To distinguish this diagnostic report from the one generated during the vehicle scan
or Auto Scan screen, we refer to it as the "Full System Diagnostic Report".

Go to "Report" on the main diagnostic screen and click "Diagnosis Report" to view all
diagnostic reports generated. Click to view the report you would like to review
according to the date and time it's generated or share to an email by clicking "Share
by E-mail" or print it out by clicking "Print PDF Report".

4.14 Full System Diagnostic Report
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4.15 Fault Code Report
The other way to generate diagnostic report is through the vehicle scan/Auto Scan
result screen. When you have done scanning all available vehicle electronic control
modules, a generate "Report" option is available at the bottom which generates a
simplified version diagnostic report that only displays the fault codes retrieved and
the vehicle systems impacted. We call this report as "Fault Code Report" to
differentiate it from the "Full System Diagnostic Report". And a typical "Fault Code
Report" is as shown in picture below:

NOTE:
The diagnostic report generated on the vehicle scan/Auto Scan screen, namely "Fault
Code Report" is generated to show the fault codes for quick repair. While the
diagnostic report generated exiting diagnostic menu is a "Full System Diagnostic
Report" to show health conditions of all vehicle systems equipped.Both of the
reports are stored in the "Diagnosis Report" section and there are actually NO such
labels attached to the reports to differentiate them as "Full System Diagnostic
Report" or "Fault Code Report".
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4.16 Diagnostic Speed
The Diagnostic Tool provides fast all vehicle modules scan and diagnostics. However,
the time it takes to scan & diagnostic all vehicle modules varies across vehicles.
Factors that could influence the diagnostic speed includes the vehicle
communication protocol the vehicle uses and number of vehicle control modules it's
equipped.

Generally speaking, the Diagnostic Tool scans all vehicle modules faster for vehicles
using latest vehicle communication protocols than older ones. For example, scanning
a vehicle uses CAN protocol for vehicle communication takes less time than an older
IOS9141 protocol.

And it takes longer time to scan a modern vehicle that has many modules equipped
than a less sophisticated vehicle that has just a few modules available.

4.17 Integrated Module
In some cases, particularly with older vehicle models, manufacturers may integrate
two or more electronic control systems into a single vehicle module. This integration
can sometimes lead to confusion or complexity during diagnostics and repair
processes.

Listed below are two most common examples:
Powertrain Control Module(PCM)- Integrates Engine and Transmission systems.
Brake Control Module(BCM)- Integrates ABS and EPB systems.

The information above indicates that if you cannot find "Transmission" or a similar
name in the diagnostic menu, you should locate "Transmission Oil Temperature"
under the PID data (live data) menu of the Powertrain Control Module (or PCM).
Similarly, if you are looking for the ABS Bleeding feature, you should go to the Special
Function under the Brake Control Module (BCM). This approach helps navigate and
locate specific diagnostic features within the Diagnostic Tool's interface.
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5.OBD-II/EOBD
This chapter describes the concept, protocols, test functions and the basic operation
of the OBD-II/EOBD function. To find OBD-II function, go to Diagnostic- Region
Selection- OBD-II.

This option presents a quick way to check for DTCs, locate the cause of an
illuminated malfunction indicator lamp (MIL), check monitor status prior to
emissions certification testing, verify repairs, and perform a number of other
services that are emissions-related.
The OBD-II function allows you to access "generic" OBD-II data.
Generic OBD-II data is data limited to emission related diagnostics such as:
• Checking for emissions-related diagnostic trouble codes (DTCs)
• Checking the cause of an illuminated malfunction indicator lamp (MIL)
• Checking monitor status prior to emissions certification testing

To access other available electronic control module (ECU) data for vehicle specific
systems, parameters or enhanced diagnostics use the "AUTO SCAN" or "Diagnostic"
and enter all systems diagnostics or individual system diagnostics. The OBD-II
function are used to access "generic" OBD-II/EOBD data for OBD-II/EOBD compliant
vehicles that are not included in the all systems/individual systems diagnostics.
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IMPORTANT:
Generic OBD-II data are not included in the engine system diagnostic data.

5.1 OBD-II Protocols

Global OBD uses 5 communication protocols:
• J1850PWM
• J1850VPW
• ISO 9141-2
• ISO 14230-4
• ISO 15765-4(CAN)

5.2 Basic Operations
To access generic OBD-II data, please follow the steps below:
Step 1: Click "Diagnostic" on the main diagnostic screen
Step 2: Select the region where the vehicle manufacturer is originated
Step 3: Click "OBD-II" icon beside the DEMO
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5.3 Auto Scan & Protocol Selection
And there are two options to access the OBD-II data of the vehicle connected.

5.3.1 Auto Scan
When this option is selected, the Diagnostic Tool attempts to establish
communication by sequentially trying each protocol in order to determine which
one the vehicle uses for communication. This method helps the tool identify and
connect with the vehicle's electronic control modules using the appropriate
communication protocol.

5.3.2 Protocol Selection
A communication protocol serves as a standardized method for data exchange
between an ECM (Electronic Control Module) and a Diagnostic Tool. Knowing the
specific protocol your vehicle uses facilitates direct selection of the corresponding
protocol. This ensures effective communication between the Diagnostic Tool and the
vehicle's electronic systems, using the correct protocol for accurate diagnostics and
troubleshooting.

5.3.3 Help
Describes DLC location, DTC library, Abbreviations and OBD background information
like OBD-II modes and etc.
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5.4 10 Modes of OBD-II
Mode $01 – I/M Readiness
Mode $02 – Read Freeze Frame
Mode $03 – Read Trouble Code
Mode $04 – Clear Trouble Code
Mode $05 – O2S Monitoring Test
Mode $06 – On-Board Monitor Test
Mode $07 – Read Trouble Code
Mode $08 – Component Test
Mode $09 – vehicle information
Mode $0A – Read Trouble Code

5.5 Connecting the Main Cable
Connection of the main cable to the Diagnostic Tool and vehicle OBD-II port is
required for OBD-II testing, see Connecting the Main Cable‚ on page 27.

5.6 OBD-II/EOBD Menu

5.6.1 Read Trouble Code

The "Read Trouble Code" option displays a list of current emission related DTCs,
including Stored Codes(Generic Codes and Manufacturer-Specific Codes), Pending
Codes, and Permanent Codes.
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OBD-II codes are prioritized based on their emission severity, with higher priority
codes taking precedence over lower priority ones. This prioritization affects whether
the Malfunction Indicator Lamp (MIL) illuminates and how the code erase procedure
is managed. Different vehicle manufacturers implement these priorities in varying
ways, resulting in differences in how codes are ranked and addressed across various
makes and models.

5.6.1.1 Stored codes

Stored codes are the current emission related DTCs from the ECM of the vehicle.

OBD-II Codes have a priority according to their emission severity, with higher priority
codes overwriting lower priority codes. The priority of the code determines the
illumination of the MIL and the code erase procedure. Vehicle manufacturers have
implemented the ranking differently, so there are differences between makes.

5.6.1.2 Pending Codes

The purpose of this function is to enable the Diagnostic Tool to obtain "pending" or
maturing diagnostic trouble codes. These are codes whose setting conditions were
met during the last drive cycle, but need to be met on two or more consecutive drive
cycles before the DTC actually sets.
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Use this function following a vehicle repair and code clearing procedure to verify test
results after a single drive cycle.
● If a test failed during the drive cycle, the DTC associated with that test is reported.
If the pending fault does not occur again within 40 to 80 warm-up cycles, the fault
is automatically cleared frommemory.

● Test results reported by this function do not necessarily indicate a faulty
component or system. If test results indicate another failure after additional
driving, then a DTC is set to indicate a faulty component or system, and the MIL is
illuminated.

5.6.1.3 Permanent Codes

This option displays a record of any "Permanent" codes. A permanent status DTC is
one that was severe enough to illuminate the MIL at some point, but the MIL may
not be on at the present time.
Whether the MIL was switched off by clearing codes or because the setting
conditions did not repeat after a specified number of drive cycles, a record of the
DTC is retained by the ECM. Permanent status codes automatically clear after repairs
have been made and the related system monitor runs successfully.

5.6.1.4 Generic & Manufacturer-Specific Codes

Code Definitions:
Diagnostic Trouble Code (DTC) -- Trouble codes are how OBD-II identifies and
communicates to technicians where and what on-board problems exist. The first
number in the DTC indicates whether the code is an SAE generic code (applies to all
OBD-II systems) or is specific to the vehicle manufacturer. The remaining three
numbers provide information regarding the specific vehicle system and circuit. An
analysis of a typical OBD-II code is shown below.
Generic Codes -- DTC with the second character as "0" is a Generic Code.
Manufacturer-Specific Code -- DTC with second character as "1" is a
Manufacturer-Specific Code.
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5.6.2 Permanent Codes

5.6.2.1 First DTC Character
The first DTC character is always a letter. There are four types of codes:

● P codes, "P" indicates a problem with the powertrain. It includes the engine,
transmission, drivetrain, and fuel system.
● C codes, "C" indicates a problem with the chassis. It refers to mechanical systems
outside the passenger compartment, such as steering, suspension, and braking.
● B codes, "B" indicates a problem with the body. It covers parts that are found in
the passenger compartment area.
● U codes, "U" indicates a problem with the vehicle's onboard computers and
integration functions that the OBD manages.

5.6.2.2 Second DTC character
The second DTC character is a numeric digit, either a "0" or a "1":

0, A "0" indicates a standard SAE international code. It's also known as a generic
code, meaning that it applies to all vehicles following the OBD-II international
standard.
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1, A "1" represents a code that is specific to the car's make or model. It's known as
an enhanced code, meaning it doesn't fall under an SAE standard. If you see a "1,"
reach out to the vehicle manufacturer directly for more information.

5.6.2.3 Third DTC character
If the second DTC character is a "0," then the third character helps you determine
which subsystems are malfunctioning. There are eight numbers:

0, Fuel and air metering and auxiliary emission controls

1, Fuel and air metering injection system

2, Fuel and air metering (injection system)

3, Ignition systems or misfires

4, Auxiliary emission controls

5, Vehicle speed control, idle control systems, and auxiliary inputs

6, Computer output circuit

7-8, Transmission

5.6.2.4 Fourth and fifth DTC character

The fourth and fifth DTC codes are two-digit numbers from 0 to 99, known as the
"Specific Fault Index." It identifies the exact malfunction that a vehicle has.

5.6.3 Clear Trouble Code(Mode $04)
This option is designed to erase all emission-related diagnostic data stored in the
memory of the selected ECM. This includes Diagnostic Trouble Codes (DTCs), freeze
frame data, and test results. While OBD-II/EOBD displays generic data only, clearing
codes removes all stored information, including any enhanced codes and freeze
frame details.
When you select the clear codes function, a confirmation screen appears to prevent
accidental data loss. You must choose "Yes" on the confirmation screen to proceed
with the operation.
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5.6.4 Live Data(Mode $01)
Use this function to view current emission-related data from the selected electronic
control module (ECM) of the vehicle. The main screen layout consists of two primary
columns: the left-hand column provides descriptions of each parameter, while the
right-hand column displays the corresponding parameter values along with their
units or states.

5.6.5 Read Freeze Frame(Mode $02)
Freeze frame data provides a snapshot of critical parameter values at the moment a
diagnostic trouble code (DTC) is set. This function allows you to display freeze frame
data for any stored emission-related DTC. Typically, the stored freeze frame data
corresponds to the last DTC that occurred.
However, for certain DTCs that have a significant impact on vehicle emissions,
priority is given. In these cases, the highest priority DTC is the one for which the
freeze frame records are retained, ensuring critical diagnostic information is
preserved.

5.6.6 I/M Readiness(Smog Check)
This function is used to check the readiness of the monitoring system. It is an
excellent function to use prior to having a vehicle inspected for compliance to a state
emissions program. Selecting I/M Readiness opens a sub-menu with two choices:
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5.6.7 Since DTCs Cleared
Displays the status of monitors since the last time the DTCs are cleared.

5.6.7.1 This Driving Cycle
Displays the status of monitors since the beginning of the current driving cycle.
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5.6.8 O2S Monitoring Test(Mode $05)
This option opens a menu of tests designed to check the integrity of the oxygen
sensors (O2S). Selecting a test displays all pertinent O2S parameters specific to that
test. The test ID is prominently displayed at the top of the data list.

5.6.9 On-Board Monitor Test (Mode $06)
This function allows you to view the results of On-Board Monitor tests. The tests are
useful after servicing or after erasing a vehicle’s control module memory.

The data provided pertains to specific systems and components that the onboard
diagnostic system continuously monitors, such as misfire counters, as well as those it
monitors intermittently. Selecting a specific system or component displays its
corresponding test results.
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5.6.10 Component Test(Mode $08)
This function enables bidirectional control (to limited extend) of the ECM. The
purpose of this function is to allow the Diagnostic Tool to control the operation of an
onboard system, test, or component, such as EVAP leakage test or other test. This
function is useful in determining whether the ECM responds to a command well.

5.6.11 Read ECU information
This function displays the names of some ECUs (Electronic Control Units) and the
protocols supported by the device. It also provides calibration information for the
device.

5.6.12 Read Vehicle Information(Mode $09)
The purpose of this function is to enable the Diagnostic Tool to request and display
vehicle-specific information, such as the vehicle identification number (VIN), the
calibration identification, and the calibration verification number (CVN), of the test
vehicle.
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IMPORTANT:
Not all vehicles support all service modes, so the available menu selections will vary
accordingly.

6. Special Functions & Maintenance Services
This chapter details various scheduled service and maintenance functions, also
referred to as "Special Functions." A typical special function screen presents a series
of menu-driven executive commands. By following on-screen instructions to select
appropriate execution options, enter correct values or data, and perform necessary
actions, the screen prompts will guide you through the complete process for various
special functions.

6.1 Oil Light Reset
The Diagnostic Tool can be used to reset the engine oil life system, which calculates
the optimum oil life change interval based on the vehicle's driving conditions and
climate. The oil life reminder must be reset each time the oil is changed so that the
system can calculate when the next oil change is due.

This function can be performed in the following cases:
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● If the service lamp is on, you must provide service for the car. After service, you
need to reset the driving mileage or driving time so that the service lamp turns off
and the system enables the new service cycle.

● After changing engine oil or electric appliances that monitor oil life, you need to
reset the service lamp.

The operation guidelines of the Oil Reset function are shown as below:

Step 1: Enter the Oil Reset menu and select vehicle model according to the vehicle
being tested.

Step 2: Select the appropriate identification method.
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Step 3: Enter automatic setting menu.

Step 4: Confirm the [New value] you just entered, and then click "OK" at the bottom
right to complete the procedure.
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Step 5: Message of "Write successfully" displays when Oil Reset function has been
successfully performed.



72

6.2 EPB
1. If the brake pad wears the brake pad sense line, the brake pad sense line will send
a signal to the onboard computer asking for replacing the brake pad. After replacing
the brake pad, you must reset the brake pad to clear the trouble code.

Otherwise, vehicle will continue to falsely notify the driver that the brake pads are in
need of replacement.

2. A reset must be performed in the following cases:

● The brake pad and brake pad wear sensor are replaced.
● The brake pad indicator lamp is on.
● The brake pad sensor circuit is shorted.
● The servo motor is replaced.

The operation guidelines of the EPB function are shown as below:

Step 1: Enter the EPB menu and choose relevant models according to the vehicle
being tested.
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Step 2: Ensure your vehicle type.

Step 3: Enter the maintenance mode menu and release the handbrake brake.

Step 4: Wait until the message of "Successful operation" pops up. And press "OK" to
exit the menu.
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6.3 SAS
Steering Angle Sensors (SAS) System Calibration permanently stores the current
steering wheel position as the straight-ahead position in the SAS EEPROM. Therefore,
the front wheels and the steering wheel must be set exactly to the straight-ahead
position before calibration. In addition, the VIN is also read from the instrument
cluster and stored permanently in the SAS EEPROM. On successful completion of
calibration, the SAS fault codes will be automatically cleared.

To reset the steering angle, you need to first find the relative zero point position for
the vehicle to drive in a straight line. Taking this position as a reference, the ECU can
calculate the accurate angle for left and right steering.

After replacing the steering angle position sensor, replacing steering mechanical
parts (such as steering gearbox, steering column, end tie rod, steering knuckle),
performing four-wheel alignment, or repairing the car body, you must reset the
steering angle.

The operation guidelines of the SAS function are shown as below:

Step 1: Enter the SAS menu and choose the vehicle model according to the vehicle
being tested.
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Step 2: Ensure you vehicle type.

Step 3: Enter the Set steering angle sensor menu and follow the instructions
displayed.

Step 4: Follow the instructions displayed and press "OK" after completing the
instructions shown.
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Message of "Function execution is completed" displayed when SAS reset function
has been successfully completed.

6.4 BMS Reset
The Battery Management System (BMS) allows the Diagnostic Tool to evaluate the
battery charge state, monitor the close-circuit current, register the battery
replacement and activate the rest state of the vehicle.
This function enables you to perform a resetting operation on the monitoring unit of
the vehicle battery, in which the original low battery fault information will be cleared
and battery matching will be performed.
Battery matching must be performed in the following cases:

● The main battery is replaced. Battery matching must be performed to clear original

low battery information and prevent the related control module from detecting
false information. If the related control module detects false information, it will
invalidate some electric auxiliary functions, such as automatic start & stop
function, sunroof without one-key trigger function or power window without
automatic function.
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● Battery matching is performed to re-match the control module and motoring

sensor to detect battery power usage more accurately, which can avoid an error
message displayed on the instrument cluster.

The operation guidelines of the BMS Reset function are shown as below:
Step 1: Enter the BMS Reset menu and choose relevant models according to the
vehicle being tested.

Step 2: Enter the battery adjustment menu.
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Step 3: Click the "Battery Matching" icon.

6.5 Injector Coding
This function can write the identification code of the fuel injector into the ECU so
that the ECU can recognize the new injector.

After the ECU or injector is replaced, the injector code of each cylinder must be
confirmed or re-coded so that the cylinder can better identify injectors to accurately
control fuel injection.

In general cases, there is no need to perform the coding matching function after
cleaning;

The identification of the fuel injector includes its working accuracy value and type
value. When replacing an injector you need to find the corresponding model for
replacement; At present, mainstream cars support injector coding functions

The operation guidelines of the Injector Coding function are shown as below:



79

Step 1: Enter the Injector coding menu and choose relevant chassis models
according to the vehicle being tested.

Step 2: Click "injector matching" icon.
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Step 3: Select the option that matches your vehicle.

Wait until the message "Write successfully" pops up means that you have done.

6.6 DPF
The Diesel Particle Filter (DPF) function manages DPF regeneration, DPF component
replacement teach-in, and DPF teach-in after replacing the ECM.

The ECM monitors driving style and selects a suitable time to employ regeneration.
Vehicles driven a lot at idling speed and low load will attempt to regenerate earlier
than vehicles driven more with higher load and speed. For regeneration to take
place, a prolonged high exhaust temperature must be obtained.

In the event of the car being driven in such ways that regeneration is not possible,
i.e., frequent short journeys, a diagnostic trouble code will eventually be registered
in addition to the DPF light and "Check Engine" indicators displaying. A service
regeneration can be requested in the workshop using the Diagnostic Tool.
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DPF regeneration is used to clear PM (Particulate Matter) from the DPF filter through
continuous combustion oxidation mode (such as high-temperature heating
combustion, fuel additive or catalyst reduce PM ignition combustion) to stabilize the
filter performance.

DPF regeneration may be performed in the following cases:

● The exhaust back pressure sensor is replaced.
● The PM trap is removed or replaced.
● The fuel additive nozzle is removed or replaced.
● The catalytic oxidizer is removed or replaced.
● The DPF regeneration MIL is on and maintenance is performed.
● The DPF regeneration control module is replaced.

The operation guidelines of the DPF function are shown as below:
Step 1: Enter the DPF menu and choose relevant models according to the vehicle
being tested.
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Step 2: Choose the function you are going to perform.

Step 3: Click "OK" icon.

Follow the instructions on the device screen until you see a confirmation of
successful operation.
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6.7 TPMS Reset
This function allows to perform the learning and matching and resetting functions of
the tire pressure sensor.
TPMS Reset may be performed in the following cases:
● Tire replacement
● After troubleshooting tire pressure related problems
● Other causes of loss of signal from the tire pressure sensor

The operation guidelines of the DPF function are shown as below:
Step 1: For tire pressure sensor matching, some vehicle models may need the TPMS
activation tool;
Step 2:Tire pressure imbalance may also cause the tire pressure light;
Step 3: After learning process, you may need to run the car for some while before
the fault light goes off;
Step 4: This function is only available for activated tire pressure sensors. If you have
a brand-new sensor, please use the professional tire pressure device.
Even for the same model, its tire pressure system may differ by the region where it is
manufactured. Therefore, under the TPMS Reset function, we provide 6 menus for
the major automotive manufacturing regions, including Korea, Japan, USA, China,
Australia and Europe, as shown below.
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And then please enter the sub-menu by the origin region of car make and select the
vehicle model you need.

TPMS reset can be further divided into 4 methods, such as Automatic Relearn, Static
Relearn, Copy ID and OBD Relearn, which is depending on the specific model. Also,
even if the relearning methods are the same, the learning procedure may differ.

● Automatic Relearn
Step 1. Install tire pressure sensor appropriately.
Step 2. Adjust all TPMS sensors to the standard value.
Step 3. Keep the vehicle at a complete standstill status for more than 20 minutes
(with the engine off and power off).
Step 4. Drive at 30-100km/h for more than 15 minutes.
Step 5. The vehicle will automatically relearn the value, after that, the tire pressure
warning will disappear.
Step 6. If the relearn procedure fails, please repeat steps 2-5.

● Static Relearn
Step 1: Install all tire pressure sensors appropriately.
Step 2: Pull up the parking brake.
Step 3: Turn the ignition to ON/RUN with the engine off.
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Step 4: Enter the tire pressure learning mode through the instrument panel on
vehicle. There will be the corresponding prompt, which are differ from different car
make and model, please subject to the vehicle manual or consult a professional).
Step 5: Starting from the left front wheel (some models flash the turn signal at the
corresponding position), use the TPMS Activation Tool to activate the sensor, and the
vehicle will sound the horn or flash the turn signal at the corresponding position
after successful activation.

NOTE:
The first sensor should be learned within 2 minutes, otherwise please repeat step 4.

Step 6: After the left front wheel sensor is successfully relearned. For the remaining,
please activate the remaining tire pressure sensors in the order of right front, right
rear and left rear. The prompt and activation success status are the same as step 5.

NOTE:
The remaining sensor learning needs to be completed within 3 minutes, otherwise
please repeat the relearn procedure from step 4!

Step 7: Turn the vehicle off and power off. Adjust all sensors to the standard value.
Step 8: Tire pressure warning light will disappear after success. If procedure fails,
please repeat steps 4-7.

● OBD Relearn
Step 1. A TPMS Activation Tool is needed
Step 2. Install tire pressure sensor appropriately
Step 3. Adjust all TPMS sensors to the standard value
Step 4. Activate all sensors in the order of left front, right front, right rear, left rear
Step 5. Connect TPMS Activation Tool to the OBD port of vehicle and perform the
OBD relearn function to write the sensor ID
Step 6. Keep the vehicle powered off for more than 25 minutes
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Step 7. Drive at 30-100km/h for more than 15 minutes. If relearn successful, the tire
pressure warning light will go off. Otherwise, please repeat steps 4-7.

● Copy ID Relearn
Step 1. Use a TPMS Activation Tool to activate the original sensor, copy the sensor ID
to the tire pressure activation device
Step 2. And then program the copied ID into the new sensor through the TPMS
Activation Tool (The binary of ID format should be the same as the original sensor)
Step 3. Remove the original sensor that has been just copied the ID, install the new
sensor that has just been programmed, and put the tire back on

● Method 1:
Step 1. Use a TPMS Activation Tool to activate the original sensor, copy the sensor ID
to the tire pressure activation device.
Step 2. And then program the copied ID into the new sensor through the TPMS
Activation
Tool (The binary of ID format should be the same as the original sensor).
Step 3. Remove the original sensor that has been just copied the ID, install the new
sensor that has just been programmed, and put the tire back on.

● Method 2:
Step 1. Use the TPMS Activation Tool to connect the vehicle OBD port, enter the tire
pressure system, copy the ID of the sensor to be replaced.
Step 2. And then program the copied ID into the new sensor through the TPMS
Activation Tool (The binary of ID format should be the same as the original sensor).
Step 3. Remove the original sensor that has been just copied the ID, install the new
sensor that has just been programmed, and put the tire back on.

● Method 3:

Step 1. Remove the original sensor.
Step 2. Use the TPMS Activation Tool to copy the original sensor ID into the new
sensor manually (The binary of ID format should be the same as the original sensor).
Step 3. Install the new sensor to the tire correctly, set the tire pressure to the
standard value, and put the tire back on the vehicle.
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Note:
1. Tire pressure standard is usually displayed in these places:
● Vehicle owner's manual
● Label next to the driver's door (near the B-pillar)
● Drawer next to the driver's seat of the vehicle
● Fuel tank cap
2. This scanning tool is not a replacement for a TPMS activation tool. It only
provides TPMS reset/ relearn functions. Activating TPMS sensors requires a
professional TPMS activation tool. If you need a professional TPMS activation tool,
please contact us : support@xtoolonline.com .

6.8 ABS Bleeding
Anti-Lock Braking System keeps the tires from locking up immediately when there
are brakes. Keeping ABS in good condition can give full play to the effectiveness of
the brakes, shorten the braking time and distance, prevent the vehicle from skidding
and tailing during emergency braking, ensure good driving stability and steering
maneuverability, and avoid violent friction between the tires and the ground to
reduce tire wear. When the ABS contains air, the ABS bleeding function must be
performed to bleed the brake system to restore ABS brake sensitivity. ABS Bleeding
can be performed in the following cases:

● Replace the rear brake distributor pump or the front brake distributor pump.
● Severe brake fluid shortage
● Change the brake fluid

The operation guidelines of the ABS Bleeding function are shown as below:

Step 1: Enter the ABS Bleeding menu and choose relevant models according to the
vehicle being tested.

mailto:support@xtoolonline.com
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Step 2: Follow the prompt steps and complete the function.

Caution

● The ABS pump screw needs to be unscrewed

● Brake fluid will be under pressure during this process. Secure the bleed hose and

open bleeder screws slowly

● Some vehicles do not support automatic bleeding, but manually bleeding

6.9 Power Balance
This function is to shut down individual injector and monitor the power output drop
by RPM to determine the relative power contributed by each cylinder and decide
which cylinder malfunctions.

6.10 Seat Calibration
Or called Seat Configurations. This function is applied to match or configure the
seats with memory function that are replaced and repaired.
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6.12 Language Change
This function is to change the system language of the instrument cluster or control
console

6.11 EEPROM
This function works together with EEPROM adapter which is not included in this 

package to read and write data into EEPROM.

.

6.13 Transport Mode
During shipment from the factory, a vehicle is put in a partially activate state called
Transport Mode to reduce the drain on the battery. And when it arrives at the
dealership, this function is applied to deactivate or disable the Transport Mode.

6.14 Control Unit Reset
This function is to reset the ECU software when fault occurs due to abnormal
working temperature or voltage change.

6.15 Throttle
Also called Throttle Reset or Throttle Match. This function enables you to reset the
throttle actuators and the learned values stored on ECU to the default state. Doing
so can accurately control the actions of regulating throttle (or idle engine) to adjust
the amount of air intake.

6.16 Rain/Light Sensor
This function is to reset the rain/light sensor after the replacement of the rain/light
sensor or the front windshield.

6.17 A/F Reset
This function is to reset or relearn the air/fuel ratio parameters.
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6.18 HV Battery
This function is used to check the voltage of individual battery pack.

6.19 Gearbox Match
This function can complete the self-learning of the gearbox and improve the shift
quality, when the gearbox is disassembled or repaired which may cause shifting
delay or impact.

6.20 Speed Limit
This function is to remove speed limit for imported vehicle, vehicle for government
agencies or police.

6.21 Gear Learning (Crankshaft Position Variation Learn, or CASE
relearn)
This function enables you to perform tooth learning for the vehicle, to turn off the
MIL.

It needs to be performed in the following cases:
1. After the engine ECU, crankshaft position sensor, or crankshaft flywheel is
replaced.
2. The DTC "tooth not learned" is present.

6.22 Clutch Adaption
This function is to reset the clutch after the replacement of clutch or gear shifting
motor.

6.23 Stop/Start Reset
This function is used to open or close the automatic Start/Stop function via setting
the hidden function in ECU (The precondition is vehicle equipped with hidden
function and hardware is in place).
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6.24 FRM Reset
This function is to reset the Footwell Room Module when unstable voltage triggered
fault and the doors, windows, headlight malfunctions.

6.25 EGR Relearn
Also called EGR Adaption. This function is used to learn the EGR (Exhaust Gas
Re-Circulation) valve after it is cleaned or replaced.

6.26 A/C Relearn
A/C system relearn must be performed when the vehicle A/C ECU or actuator is
replaced or the ECU memory is lost.

6.27 Headlight
Also called Headlight Adjustment, Headlight Matching or AFS Reset. This function
can initialize the adaptive headlight system. The headlight system can decide
whether to automatically turn on the headlights based on the ambient light intensity,
monitor the vehicle's driving speed, body posture, etc., and adjust the headlight
lighting angle.

6.28 SRS
This function is to reset the acceleration sensor when it's replaced or it's providing
wrong data which is used for SRS system, anti-theft system or navigation system.

6.29 Windows Initialization
When the vehicle battery is disconnected, the windows may not work right. This
function is used to perform door window matching to recover the ECU initial
memory, and recover the automatic ascending and descending function of power
window.

6.30 VGT Relearn
Also called VGT Turbo Calibration. This function is used to calibrate the newly
installed component. This needs to be done every time there's an initial installation
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or swap of the VGT. This is always done when the component has been detected as
operating "out of range".

6.31 Electronic Pump Activation
Also known as Electric Water Pump Activation, this function is employed to initiate
the operation of the electric water pump following its replacement.

6.32 Suspension
This function can adjust the vehicle body height sensor for level calibration after
replacing the vehicle height sensor or control module in the air suspension system,
or when the vehicle level is not correct.

6.33 Airbag Reset
This function is used to reset the airbag system, airbag warning light when airbag has
been replaced and clear crash data.

NOTE:
Clear crash data is available to specific vehicles only.

6.34 Tire Reset
This function is to reset the tire size when it's replaced or upgraded.

6.35 Instrument Cluster
Instrument repair involves using diagnostic equipment to adjust the mileage
displayed on the instrument cluster. This can include two main procedures:
Step 1: Replacement of the Instrument: When an instrument cluster is replaced, the
original mileage needs to be written to maintain accuracy and legality.
Step 2: Adjustment of the Mileage: This allows the mileage to be adjusted either up
or down, which is sometimes referred to in the used car market as "adjusting the
meter." When purchasing a used car, it's important to check whether the mileage
has been altered or adjusted, as this can affect the vehicle's value and reliability.
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7. Settings
This chapter covers the settings for the diagnostic software or tablet, including the
tablet's language, units used in the diagnostic program, USB port mode
configuration, and more.

7.1 Language
Go to "Settings"> "Language" to change the language of the Android tablet into the
language you want to use.

To use the diagnostic program in your preferred language, please reach out to our
support team and provide the Serial Number (S/N) of your Diagnostic Tool. They will
authorize the language software program you desire. Once authorized, you'll need to
download all software programs for the new language and set the language of your
Android tablet accordingly. This ensures that the diagnostic tool operates effectively
in your chosen language.

7.2 Unit
This setting provides 3(three) sets of units to measure various sensor values.
Metric Units: Centimeters, kilometers, grams, kilo,℃,litres, pa, kpa

Imperial Units: Inch, foot, yard, oz, lb,℉,PSI, mile, galon

US Units: Inch, foot, yard, oz, lb,℉, PSI, mil, mile
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7.3 USB Setting
Click on USB setting, you can transfer the file via Bluetooth.

7.4 Sound&Display
You can adjust the volume of sound and the display of the screen.
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7.5 Subscription Info
Here, you can check the expiration date, product activation time, and SN.

7.6 About
You can check the serial number and APP version here.
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8. Software Updates
This chapter details how the software subscription operates and outlines basic
procedures for software updates.

● The subscription is an annual fee that covers compatibility with all makes and
models, rather than being tied to individual models or functions.

● Upon expiration of the subscription, you have the option to renew it immediately
or skip renewal for certain years until you are ready to update again. If you choose
not to renew, the existing software programs remain on the Diagnostic Tool but
cannot be updated to the latest versions.

● Software updates can be performed while connected to a Wi-Fi network or using a
mobile phone's hotspot. Using a mobile phone's hotspot is recommended in case
of network provider restrictions or when home Wi-Fi is unavailable.

If "Network abnormal" prompt pops up on the screen, try another Wi-Fi or check the
router settings or seek help from our support team via www.xtoolonline.com
/support.

http://www.xtoolonline.com
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To update the software programs, you have 2 (two) options:

Option 1: Update All Software Programs
Update all by clicking "Update All" at the bottom right of the update menu.

Option 2: Update Individual Software Program
Update specific software program by clicking the " "icon at the right side of the

corresponding software program. If the update is interrupted, click the " " icon
again to proceed.

Delete Software Program:

When the diagnostic tablet has taken up too much memory and become slow, the
solution is to delete the software programs you rarely use to free up some space.

Delete diagnostic software program:

To delete rarely used diagnostic software program, click "Diagnostic"- Select Region-
Press and hold the vehicle maker icon for 5 seconds that you rarely use to activate
the job menu. Click "Delete" to delete the software program.
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IMPORTANT：
It's advisable not to delete software programs close to the subscription expiration
date. Instead, it's recommended to re-download any deleted software programs
before the subscription expires. This ensures that you have access to the necessary
software even after the subscription period ends.

9. More
This chapter describes "More" options on the main diagnostic menu including your
user account, workshop information, subscription start and end date, firmware
information, endoscope and user manual.

9.1 Profile
This section enables you to manage the user account, workshop details, and check
subscription information effectively:

● Account Information: Provides options to set the user name, product registration
mailbox, reset password, and log out of the current account to facilitate logging in
with another account.

● Workshop: Allows technicians or workshops to configure essential details such as
the workshop name, address, phone number, mailbox, and website. These details
are typically included in diagnostic reports shared with customers.

● Subscription: Displays crucial information such as the Serial Number (S/N) of the
Diagnostic Tool, the start date, and the expiration date of the subscription. This
allows technicians to plan and prepare accordingly, ensuring all software programs
are updated to the latest versions before the subscription expires.
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9.2 User Manual
We plan to regularly update and improve the user manual to enhance customer
service. Physical copies of manuals often become outdated quickly. Additionally, the
digital PDF version of the User Manual includes a search function, enabling users to
locate specific information within the extensive content. This section aims to ensure
that the User Manual receives periodic updates for accuracy and relevance.

10. Other Settings

10.1 Email Settings

Step 1: Log into your Google Account and click "Security"> "2-Step Verification">
Click "Get Started" to set up 2-Step Verification> Set up a backup phone and turn on
2-Step Verification.

Step 2: When the 2-Step Verification is turned on, visit the link below to set up App
password. https://myaccount.google.com/ app passwords.

https://myaccount.google.com/
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Step 3: Set up a custom app name(D7 as in example above), to generate a password
(16 letters) to log into this custom app. Copy and save this password.

Step 4: Go to your Diagnostic Tool, swipe up to bring up the hidden toolbar menu

and click the " " icon to add a new G-mail account.
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Step 5: Input your G-mail account and the app password (16 letters) and click
"NEXT".
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Step 6: Set the sync frequency and click "NEXT" until it displays "Your account is set
up and emails are on their way".
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To Share Diagnostic Report via G-mail Account:

Go to Report> select the report you want to print> click "Print PDF Report"> click the
job menu icon on the top right corner> Click "Share"> "Email" to go to Email
composing page and sent the report via G-mail account.

10.2 Delete Email Account
Step 1: Swipe up the hidden toolbar menu, click "Settings> Accounts".
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Step 2: Select the G-mail account you added.

Step 3: Click "REMOVE ACCOUNT" and confirm.
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10.3 Printing Settings
To enable printing service on the Diagnostic Tool, you need to install Print Service
App/Print Driver first. Please go through below checklist before the installation of
the printing service:

10.3.1 Checklist for Installing Printing Service
●Make sure your printer supports Wi-Fi connection(Wi-Fi Direct)
● Check the brand, model of your printer
● Install a printing service (printer driver) that is compatible with your printer. You
have two options:

Option 1: Install universal printer service app like Mopria.
Option 2: Install official apk installation package for your printer. For example, HP
Printing Service Apk for HP printer.

10.3.2 Download Mopria Print Service APK File from Mopria website or
download the specialized printer driver for your printer

Step 1: Visit Mopria official website (or visit the printer website) or click link
https://mopria.org/ on your PC or laptop.
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Step 2: Click Print> Print from Android> Direct Download.

Step 3: Connect the Diagnostic Tool to your PC or laptop through USB Type-C cable
attached and enable data transfer by swiping down from the upper left/right corner
on the Diagnostic Tool.
Step 4: Move the Mopria Print Service apk file to the Diagnostic Tool internal storage
through Path: D7-Internal Shared Storage- Download.
Step 5: Disconnect the Diagnostic Tool from the PC or laptop and go to ES File
Explorer> Local> Home> Download to locate the apk file and click it to install on the
Diagnostic Tool.
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-

Step 6: Go to Settings Connected Devices> Connection Preferences> Printing>
Mopria Print Service> Switch to On position> Select Printer> Accept the connection
on the printer control panel.
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You may need to accept the connection to the printer on the printer's front panel to
complete the setup process successfully.
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10.4 For Printer with Wi-Fi Direct
If your printer supports Wi-Fi Direct, please follow the steps below to connect the
Diagnostic Tool to the printer directly:
Step 1: Swipe up the hidden toolbar menu and click “Settings”.
Step 2: Click Network & internet- Wi-Fi and click the printer Wi-Fi.
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Step 3: Check the SSID and password displayed on the printer's front panel and use
them to establish the Wi-Fi connection. If your printer doesn't have a front panel,
print the printer information page on a piece of paper and use the displayed SSID
and password for the Wi-Fi connection.

NOTE:
If you require technical support to set up a printer on your Diagnostic Tool, please
contact our support team via support@xtoolonline.com. Kindly provide us with the
name and model of your printer for assistance.

11. Service Center
This chapter provides information on how to contact us for warranty claims,
technical support, tutorials, marketing cooperation, business opportunities, or to
provide feedback to help us improve your Diagnostic Tool experience.
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11.1 Remote Control
This function allows you to request remote assistance from our technical team to
operate the Diagnostic Tool for tasks that you are not familiar with.

Ensure that the Diagnostic Tool is connected to Wi-Fi. Then, click on the "Remote
Control" icon to launch TeamViewer. Wait until it displays "Ready to connect (secure
connection)" at the bottom left of the screen. Note down the TeamViewer ID located
at the center right of the screen. Please schedule a remote assistance session with
us in advance.

11.2 Data Logging
For software-related issues such as vehicle communication problems or function
failures, data logging often provides crucial information for successful technical
support sessions.

To ensure we can assist you effectively, please ensure your Diagnostic Tool remains
connected to Wi-Fi for at least 15 minutes. Additionally, provide the Serial Number
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(S/N). This allows our technical team to access the data logs from the server and
begin analyzing the issue to find a solution.

11.3 App Logging
For issues related to the app, please request an app logging collection tool from our
technical support team. You can make this request whether or not a remote
assistance session is scheduled. The logging tool helps us gather detailed
information about the app's performance and any specific issues you may encounter,
ensuring more effective troubleshooting and support.

11.4 FAQ Database
This section describes how to access our FAQ database on our website. Visit
www.xtoolonline.com and then click "FAQs" or click direct link
https://www.xtoolonline.com/faqs

11.5 Training Center
To access our training videos, please visit our website and click"Support"> "Product
Videos" or click the direct link https://www.xtoolonline.com support> product>
videos.

11.6 User Programs
This section describes the programs we have for our customers.

11.7 Corporate Purchase
Whether you represent a company, school, government agency, or NGOs and you
want to buy in bulk, reach us through email: Support@xtoolonline.com and get a
bulk discount.

11.8 Inventors and Testers Program
That sounds like an exciting opportunity indeed! If you're interested in becoming a
product tester, inventor, or contributing to language improvements in the User

https://www.xtoolonline.com
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Manual, it's best to reach out to the company directly through their designated
channels. Contacting their support team or customer service would provide you with
more detailed information on how to participate in these specific programs. They
can guide you on the steps to take and any requirements needed to get involved.

11.9 U-Fluncer Program
Whether you are an influencer that have large number of social media subscribers or
amateurs that love to post content on social media platforms to to help the
community on how to perform diagnostics , this program is for you.

12. Compliance Information

12.1 FCC Compliance / FCC ID: 2AW3IP102
This device complies with Part 15 of the FCC rules and Industry Canada's
license-exempt RSSs.
Operation is subject to the following two conditions:
1. This device may not cause harmful interference.
Cet appareil est conforme aux CNR exempts de licence d’Industrie Canada. Son
fonctionnement est soumis aux deux conditions suivantes:
1. Ce dispositif ne peut causer des interferences; et
2. Ce dispositif doit accepter toute interférence, y compris les interférences qui
peuvent causer un mauvais fonctionnement de l’appareil.
2. This device must accept any interference received, including interference that may
cause undesired operation.

WARNING:
Making changes or modifications without explicit approval from the responsible
compliance authority may revoke the user's authorization to operate the equipment.

NOTE:
This equipment has undergone testing and meets the requirements for a Class B
digital device, as stipulated by Part 15 of the FCC Rules. These standards are
intended to offer reasonable protection against interference when installed in
residential environments.
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This equipment emits radio frequency energy during operation, which can
potentially interfere with radio communications if not installed and used as per the
provided instructions. While efforts are made to minimize interference, there is no
assurance that it will not occur in specific installations. If interference affects radio or
television reception, you can determine if this equipment is the cause by powering it
off and on. To mitigate such interference, consider the following measures:
● Reorient or relocate the receiving antenna.
● Increase the separation between the equipment and the receiver.
● Connect the equipment to an outlet on a circuit different from that to which the
receiver is connected.
● Consult the dealer or an experienced radio/TV technician for assistance.

Changes or modifications not expressly approved by the party responsible for
compliance could void the user's authority to operate the equipment.

12.2 SAR
The device's emitted radio frequency power adheres to FCC regulations on exposure
limits. To ensure safe usage, it's recommended to minimize human contact with the
device during its regular operation.

FCC guidelines for wireless devices assess exposure through the Specific Absorption
Rate (SAR), which is capped at 1.6 W/kg. SAR evaluations follow standard
operational positions recognized by the FCC, where the device transmits at its
highest certified power level across all tested frequency ranges.

Although SAR is measured at peak power, actual exposure during normal use tends
to be lower. This is because the device adjusts its power output based on network
requirements, utilizing only the necessary power for connectivity.

To maintain compliance with FCC standards regarding radio frequency exposure, it's
prudent to reduce human proximity to the device's antenna whenever feasible.



116

12.3 RF Warning Statement
The device has been evaluated to meet general RF exposure requirement.
The device can be used in portable exposure condition without restriction.
The term “IC” before the radio certification number only signifies that IC technical
specifications were met.

12.4 RoHS Compliance
This device complies with the European RoHS Directive 2011/65/EU, which restricts
the use of certain hazardous substances in electrical and electronic equipment.

12.5 CE Compliance
This product conforms to the essential requirements of the following Directives and
bears the CE mark accordingly:

EMC Directive 2014/30/EU
R&TTE Directive 1999/5/EC
Low Voltage Directive 2014/35/EU

13. Warranty
Limited Two-Year Warranty
Shenzhen XTOOLtech Intelligent Co., LTD.(the Company) warrants to the original
retail purchaser of this XTOOL device that should this product or any part thereof
during normal usage and under normal conditions be proven defective in material or
workmanship that results in product failure within two year from the date of
purchase, such defect(s) will be repaired, or replaced (with new or rebuilt parts) with
Proof of Purchase, at the Company’s option, without charge for parts or labor
directly related to the defect(s).

The Company shall not be liable for any incidental or consequential damages arising
from the use, misuse, or mounting of the device.
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This warranty does not apply to:

1.Products subjected to abnormal use or conditions, accident, mishandling,neglect,
unauthorized alteration, misuse, improper installation/repair or, improper storage;
2. Products whose mechanical serial number or electronic serial number has been
removed, altered, or defaced;
3. Damage from exposure to excessive temperature or extreme environmental
conditions;
4. Damage resulting from connection to, or use of any accessory or other product
not approved or authorized by the Company;
5. Defects in appearance, cosmetic, decorative, or structural items such as framing
and non-operating parts;
6. Products damaged from external causes such as fire, dirt, sand, battery leakage,
blown fuse, theft, or improper usage of any electrical source.
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14. Contact Us
Warranty & Support
E-mail: support@xtoolonline.com
Website: https://www.xtoolonline.com/
For Wholesale Business or Become our Distributors:
https://www.xtoolonline.com/to-be-dealer
Share us with your friends, join our community to get tutorials, support and more.
Scan QR code below to subscribe to our social media:

TikTok Instagram Facebook

Facebook:
https://www.facebook.com/XTOOLonline

Instagram:
https://www.instagram.com/xtoolonline/

Tiktok:
https://www.tiktok.com/@xtoolonlineus

YouTube:
https://www.youtube.com/@xtoolonline

Invent with us, test products before they hit market, help us make better products
for everyone:
E-mail: inventers@xtool.com

Create social media content, post online and help our community:
F-mail: marketing@xtool.com

https://www.xtoolonline.com/
https://www.facebook.com/XTOOLonline
https://www.instagram.com/xtoolonline/
https://www.tiktok.com/@xtoolonlineus
https://www.youtube.com/@xtoolonline
mailto:inventers@vdiagtool.com
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15. Appendix

15.1 Navigation Path Quick Check
Misfire Counters: Go Diagnostic> Auto Scan> ISO 15765-4 Module $000007E8>
On-Board Monitor Test> Misfire Cylinder 1 Data> Misfire count for last/current
driving cycles

Fuel Loop Status: Go Diagnostic> Region> Make> Model> Year> System Selection>
Full System Diagnosis> Engine Electronics> Live Data> Packet Data flow> Status of Oil
Pressure Switches
Readiness Status(Smog Check): Go Diagnostic> OBD-II> I/M Readiness Status

Transmission Oil Temperature: Go Diagnostic> Region> Make> Model> Year> System
Selection> Full System Diagnosis>Transmission> Live Data> Transmission Fluid
Temperature Filtered

Cam Crank Relearn: Go Diagnostic> Region> Vehicle Selection> System Selection
Engine or ECT or Powertrain- Special Function> Cam Crank Relearn or Crank Pattern
Learning

Crankshaft Position Variation Sensor Relearn: Go Diagnostic> Region> Vehicle
Selection> System Selection> Engine Control Module/ Powertrain> Special Function>
Crankshaft Position Variation Learn

Service Bay Test: Go Diagnostic> Region> Make> Model> Year> System Selection>
Full System Diagnosis> Engine Electronics> Actuation Test> EVAP Canister Purge
Regulator Valve

VGT Turbo Calibration: Go Diagnostic> Region> Vehicle Selection> System Selection
Drive Train Control Module> Special Function> Turbo Actuator Pre-Align/Self
Calibrate
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15.2 Terms & Terminology Quick Check
LTFT= Short for Long Term Fuel Trim
STFT= Short for Short Term Fuel Trim
MIS= Short for Misfire
I/M Readiness Status= Technical term for Smog Check
VGT Turbo Actuator Calibration= Turbo Actuator Pre-Align/Self Calibrate
Cam Crank Relearn= Cam Pattern Relearn
Crankshaft Position Variation Learn= Crankshaft Relearn= CASE Learning= Gear
Learning
Actuation Test= Active Test=Component Test= Bi-Directional Control

15.3 FAQs
Q1: I haven't found I/M readiness in the menu.
A: Please enter Diagnostic>Select America/Europe/Asia>Click the "OBD-II" icon on
the top left of the screen>Auto Scan/Select OBD-II Protocol>I/M Readiness

Q2: Unable to find live sensor data as the generic OBD2 scanner, like
short-term/long-term fuel trim.
A: Please enter Diagnosis>Select America/Europe/Asia>Click the "OBD-II" icon on the
top left of the screen>Auto Scan/Select OBD-II Protocol>Live Data>LTFT, STFT or
similar term .

Q3: Unable to find the misfire data for my Ford/Dodge/Chrysler/Jeep cars?
A: Please Select Diagnostic> America/Europe/Asia>OBD-II (On the top left of the
screen)>Auto Scan or Select OBD-II Protocol for your car>On Board Monitor
Test>Select "Misfire Cylinder Data" or similar term.

Q4: How to export live data as CSV files?
A: How to generate CSV files: Live data>custom> Choose which live data you want to
generate> Record > Save> Preview
How to find the CSV files: Report> CSV View> Choose the live data you have saved
just now
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Q5: I can not charge the battery now. I plugged in the cord, it's not charging. The
battery is almost dead, only about 10% left.
A: Please charge it for over an hour, unplug it from the charger, then press and hold
the power button for 15 seconds and see if it solves the issue. Please unplug the
Type-C cable from the Diagnostic Tool and press and hold the power button for 15s,
and check if it can power up successfully.

Q6: Can scanner tune up car?
A: Sorry, D7 Diagnostic Tool does not have the capability to tune up car.

Q7: Can this scanner still be used once the 3 year free updates are finished？
A: Yes of course, you can still use its last updated software when it expires, even
when it expires after three years.

Q8: It was frozen until the battery went flat even I tried the reset button and the
power button.
A: Please make sure you have updated the App to the latest version(To update the
App to the latest, go to Settings> About> App> click the arrow at the right side to
check the latest App version and update to the latest.). If yes, please reset to factory
settings and check again. If it still does not work, please reach us directly via
support@xtoolonline.com.

Q9: I cannot update, I've tried Wi-Fi and cell phone as hotpot, however, keep
telling me failure connection.
A: This problem could reside with the setting of your router firewall or the network
provider in your region that restricts access to the server, please check if your router
firewall can access the server or not. If the problem still exists, please reach us via
support@xtoolonline.com.

Q10: Any chance to install Google play store?
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A: We are sorry that this diagnostic tool does not support installing Google Play store.
However, if you want to install a third-party app, you can download apk file and
install it on the diagnostic tool. We don't recommend installing other third-party
apps as it may slow down its running speed.

Q11: Why should I connect the scanner to internet once a month?
A: It's a government policy compliant requirement to connect the device to Wi-Fi
once a month to report IP location to prevent the device being used for illegal
activities. If connecting it to Wi-Fi did not solve the issue, please reach us directly via
support@xtoolonline.com ASAP.

Q12: The auto scan/VIN cannot work on my vehicle.
A: As for auto scan/VIN, it does not cover all vehicles as some vehicles did not store
VIN in the ECU, some VIN is not included in our coverage database, and some
vehicles like Dodge work in "sending command, answering command" mode for
vehicle communication.

You can try below alternative navigation methods:
● Turn on the ignition and not start the engine to try auto scan. For older vehicles,
please turn on the ignition and start the engine and try auto scan.
● Manual input VIN.
● Diagnosis> America/Europe/Asia> Vehicle Selection> Automatic Detection.
● Diagnosis> America/Europe/Asia> Vehicle Selection> Manually Selection.

Q13: My diagnostic tool cannot connect to Wi-Fi.
A: If it shows "times out", please check your router and make sure that your router
selected WPA2, not WPA3(maximum compatibility), and that it has not blocked the
outgoing network traffic to non-US regions like China. Switching to mobile phone
hotspot will most likely solve the registration issue. You can switch back to home
Wi-Fi for software downloads when activation is done.
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The second method is to connect to the Wi-Fi extender. If you have the Wi-Fi main
modem and the extender. You can try to disconnect the diagnostic tool from the
main Wi-Fi and connect it to the internet via the extender.

If it has connected to the internet but shows "connect internet to sync your device",
the problem is that the country and time zone (china time zone) in the Android
system didn't match what the network time zone was (pacific time zone) and is
preventing it from syncing. Please just correct the time zone to pacific time zone by
entering main screen> settings> System> Date & Time> "select time zone".

Q14: How can I change the menu language into Spanish?
A: To change the menu language, please send the S/N of the diagnostic tool to our
support team via support@xtoolonline.com and get Spanish software program
authorization. When the authorization is done, go to "Settings" on the diagnostic
menu> language> Spanish to change the language of the Android tablet into Spanish,
then go to "Updates" download all software programs. When all software programs
in Spanish have been downloaded and installed, you may use the diagnostic tool in
Spanish.

Q15: Why the scanner shows the report shared successfully but the email box
didn't receive the report?
A: As the all the reports are sent by our email: service@xtool.com, the email may be
blocked even the device shows "send successfully". Since you use Gmail, you can
follow below instructions to whitelist our sending mailbox: service@xtool.com
https://downtimemonkey.com/blog/how-to-whitelist-an-email-address-in-gmail.php

Not everyone needs to set up the whitelist, since not all the email from our mailbox
will be blocked by received mailbox. You may also check your junk email to see if
there is any email from service@xtool.com.

Q16: When you enter the diagnosis software program, it shows
"license exception" or "Failed" error message.

mailto:support@xtoolonline.com
mailto:service@vdiagtool.com
https://downtimemonkey.com/blog/how-to-whitelist-an-email-address-in-gmail.php
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A:Please try to delete the software programs by press and hold it and then
re-download it again under the "Updates" to check whether this issue is solved or
not. If not, please contact the our support team via support@xtoolonline.com with
the S/N of the diagnostic tool.

Q17: Browser can access internet normally, but can not download the updates
under "Updates", prompted to check the network connection in the Update.
A: Please switch to mobile hotspot or other Wi-Fi and try again.

Q18: The device cannot be charged/powered on when connected with the car or
plugged into the charger.
A: Please charge for more than one hour first, unplug the charger, press and hold the
power button for 15 seconds and to check if it will turn on, and also confirm whether
the device screen will light up when charging and try to press and hold the power
button for more than 10s to try several times while charging. If the device still won't
turn on, please contact our support team with S/N.

Q19: When activating the device, shows error message "registration failure" after
entering your email address.
A: Try mobile hotspot (recommended) or a different network to activate.

Q20: Received a used device with a lock screen password, unable to open the
device
A: Contact our support team with the device's S/N via support@xtoolonline.com to
resolve the issue.

Q21: How to use the function of "Remote Control"?
A: The "Remote Control" menu is generally used when you need tech support from
us and we are not able to help you fix it via emails. Then we will set an appointment
with you first at a time that is suitable for you and the engineers. You are not able to
start a remote control without an appointment because we don't know that you
started it. There are too many devices sold in the market, we are not able to remote
with all customers if they start the remote at the same time without appointment.
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Q22: What is the update fee of D7? After my D7 pass the free subscription date,
can I use it as usual as before?
A: The renewal fee of D7 after three years is $99 per year.

D7 has a 3-year free update validity period. Three years later, the previously
downloaded and updated software packages can still be used, but the latest
software packages cannot be obtained if you don't pay the renewal fee. If you want
to update the D7 after three years, fourth year, or fifth year, you can contact us to
extend 1-year period which costs $99.
After subscription, you can get all the newest software.

For example, if you decide to not get updates on the fourth year and fifth year, and
would like to get updates on the sixth year, you just need to contact us to extend the
period which costs $99, then you can get all the newest software and you can get
updates for a whole year.

Q23: How can I subscribe the update on my D7?
A: The update fee for the D7 is $99 per year. If you wish to subscribe, please proceed
by transferring the payment directly to info@acartool.com via PayPal. Once the
transfer is complete, kindly provide us via support@xtoolonline.com with a
screenshot of the transaction. We will promptly add the update to your device
within 24 hours.

Q24: I don’t want to register an account. Why I failed to perform the functions at
the trial mode?
A: Trial mode is not designed for vehicle coverage or compatibility checks. Its main
purpose is to offer practice and help users become familiar with the functions and
user interface of the diagnostic tool. Therefore, the function will limited if you don't
register a new account, so we recommend that you register an account to use the
tool on your vehicle, which will be more convenient.
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Of course, if you still fail to perform the function you want after registering an
account, please feel free to contact us via support@xtoolonline.com with the
following information:

1. S/N printed back on your device
2. VIN of your vehicle
3. The functions you tried to perform but failed

Q25: When using the trial mode, do I need to connect my device to the Internet/
Wi-Fi?
A: No, you don't need connect your device to the Internet/ Wi-Fi when you are in
the trial mode.

Q26: Shall I connect my device to the Internet/ Wi-Fi all the time?
A: No it doesn't need an Internet connection all the time. You just need to register it
and download the updates with internet connection. For some special vehicles like
Peugeot, scan tools need to be connected to the Internet, because it is required by
the manufacturer. It will require internet connection when you are doing some
advanced features like ECU Programming.

Q27: Does your tools can support all the functions on all vehicles?
A: All our tools are comprehensive diagnostic tools that can work on many vehicle
brands, but it cannot do all the functions on all vehicles, just like any other scan tools
in the market, even the factory scanner can only do functions on their own brand.
Because not all vehicles come with the same functions when manufactured and
even the vehicles of the same model might have various configurations.

Q28: Why I manually enter the VIN on my device, the letters of Q, I, O on the
keyboard are gray?

A: Because the three letters Q, I and O are easily confused with other characters,
such as the numbers 1 and 0. Therefore, VIN standards (including ISO standards and
SAE standards and Chinese national standards) stipulate that the three characters of

mailto:support@xtoolonline.com
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I, O and Q cannot be used. So it's normal that these three letters on the keyboard
are gray. You can use the device normally.

Q29: How can I transfer the device’s data to my phone or PC?
A: For your phones, If it is iOS, our tablet does not support file transfers to iOS
devices. If it is Android, please agree to receive the transfer on your phone after
clicking Bluetooth transfer on the tablet. If your phone is Android and it is still not
work after you tried the steps above, please kindly try connecting to a computer to
transfer the files.

Here are the steps for your reference:

Step 1: Connect the Diagnostic Tool to a PC by using a Type-C cable. Insert one end
into the Type-C port on the Diagnostic Tool and the other end into a USB 2.0 port on
the PC.

Step 2: Swipe down from either the upper right or upper left corner of the
Diagnostic Tool to bring up the drop-down menu. Click on "Android System. Charging
this device via USB".

Step 3: Change the option from "No data transfer" to "File Transfer".

Step 4: On the PC, check the connected devices and click on "D7" to access and
manage the files stored in the internal memory of the Diagnostic Tool.
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